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Steps to Batch Replicate Testing Sessions 

Overview 
 

With release of TOPSpro Enterprise Online Version: 2.0 Build 299, the Batch Replicate feature was 

introduced to copy multiple Testing Sessions from the current program year (July 1, 2015 – June 30, 

2016) to the new program year (July 1, 2016 – June 30, 2017). 

 

The CASAS Technology Support Team at techsupport@casas.org is available to provide technical 

assistance if needed. This e-mail address alerts several members of the team to ensure you receive a 

timely response. Team members are available 6:00 am – 5:00 pm (Pacific), M – F, and may also be 

contacted at 1-800-255-1036, option 2. 

 

Step Display Description 

1.  

 

 To access TOPSpro Enterprise Online for the 

first time on a local computer, 

 

o At top left of the web browser window, 

 

 Click (Install) link. 

 

 A client application will install on the local 

computer to connect with the online server. 

 

2.  

 
 

 

 A TE shortcut icon is automatically placed on 

the computer desktop. 

 

 If you are a user who will access TE frequently, 

you may want to pin the shortcut icon to your 

Taskbar along the bottom of your computer 

monitor for quick access when other 

applications are open on your screen. 

 

 

3.  

 

 TE opens to a log in screen similar to eTests 

Online except that you need to specify the 

Server from the drop-down menu. 

 

o Click the Server field down-arrow. 

 

o Click to select the Server in your state. 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
mailto:techsupport@casas.org
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Step Display Description 

4.  

 
 

 Users enter the same log in credentials to 

access eTests Online and TE Online because 

there is only one database shared between 

both applications. 

 

o Enter User credentials. 

 

o Click Connect to establish connection to 

the online server. 

5.  

 

 To view a list of Testing Sessions from TE as 

seen in eTests Online, 

 

o Click Organization, and then 

 

o Click Testing Sessions. 

 

 Users may have access to different menus and 

data functions in TE based on the TE Access 

Group in which their user account is placed. 

 

o Contact your agency’s online data 

manager if needed for access. 

 

 

 

6.  

 
 

 The Testing Sessions list of records opens to 

display sessions from all program years. 

 

 To filter for Testing Sessions in the 2015-16 

program year, 

 

o From the Toolbar at top left of the list, 

 Click the Filter icon from the 

Program Year column header. 

 

o From the Program Year drop-down 

menu, 

 Check 7/1/2015 - 6/30/2016. 

 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
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Step Display Description 

7.  

 
 

 At least two Testing Session records must be 

selected to activate the Batch Replicate 

function. 

 

 To select multiple Testing Sessions, 

 

o Use the Ctrl + A key-command to select 

all sessions listed in consecutive order. 

   – OR –  

o Use the Ctrl + Click key-command to 

select non-consecutive sessions from the 

list. 

 

8.  

 
 

 After selecting Testing Sessions, 

 

o Click Batch Replicate from –  

 

 The Toolbar at top of the list of 

Testing Session records. 

   – OR –  

 The More button at top right of the 

list of Testing Session records. 

 

9.  

 
 

 To replicate selected Testing Sessions in the 

7/1/2016 – 6/30/2017 Program Year, 

 

o Click Replicate Sessions at bottom of the 

pop-up window. 

10.  

 
 

 To confirm replicating the selected Testing 

Sessions –  

 

o Click Yes. 

   – OR –  

o Click No and repeat Steps 7 – 9. 

 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
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Step Display Description 

11.  

 
 

 The Batch Replicate wizard will begin 

replicating selected Testing Sessions for the 

new program year starting 7/1/2016. 

 

o Please wait… 

 

12.  

 
 

 A pop-up message will display when all 

selected Testing Sessions have been 

replicated. 

 

o Click OK to close the pop-up message. 

 

13.  

 
 

 To see a list of replicated sessions for the new 

Program Year, 

 

o From the Toolbar at top left of the list, 

 Click the Filter icon from the 

Program Year column header. 

 

o From the Program Year drop-down 

menu, 

 Check 7/1/2016 - 6/30/2017. 

 

14.  

 
 

 The Testing Sessions list of records now 

displays replicated sessions for the 7/1/2016 – 

6/30/2017 Program Year. 

 

15.  

 
 

 Testing Sessions for the 7/1/2016 – 6/30/2017 

Program Year will also be listed and ready to 

use in eTests Online. 

 

 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
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Steps to Create Testing Sessions 

Overview 
 

To get up and running smoothly with testing in the new program year, you may want to start “fresh” 

with establishing Instructional-Program Templates in your eTests Online account. These templates will 

ensure standardized test delivery with NRS approved assessments for WIOA compliance and College 

and Career Readiness (CCR). 

 

 Creating Testing Sessions is a one-time task as when registering computers. 

 

 Only certified coordinators may create, edit, copy, or delete Testing Sessions. 

 

 Coordinators establish a Template to ensure standardized test delivery for all programs using 

eTests Online. 

 

 From this Template, sets of sessions are added and customized based on recommended best 

practices. 

 

 Templates are site-specific. 

o Any edit to an instructional-program Template at each site will have a simultaneous 

effect in editing all sessions sharing the same Template at that site. 

 

 If you have more than one lab at a site, additional sets of sessions must be added for proctors to 

manage per lab. 

o The session description (not the Template) should include the lab name. 

 

 The set of sessions may be copied to quickly add additional sessions. 

o Sessions sharing the same Template within the same site may be copied in any order. 

o The first session copied to a new site will establish the Template at that site so it is very 

important to copy the first session in a Template set of sessions to establish the 

Template at the new site. 

 

 After sessions are added, they are ready to use and reuse whenever testing is needed 

throughout the program year. 

o Reusing sessions ensures standardized test delivery and testing practices. 

o The most-used sessions in a set are the pretest and post-test sessions, and remaining 

sessions are used “as needed.” 

 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
https://www.casas.org/training-and-support/wia-and-nrs-compliance/nrs-approval-of-casas
https://www.casas.org/training-and-support/wioa-and-nrs-compliance
https://www.casas.org/product-overviews/curriculum-management-instruction/CCCS/2014/10/20/college-and-career-readiness-standards-overview
https://www.casas.org/product-overviews/curriculum-management-instruction/CCCS/2014/10/20/college-and-career-readiness-standards-overview
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 Multiple sessions may be active simultaneously to deliver tests according to the session 

description. 

 

 We recommend that you not assign stations to sessions so that proctors have maximum 

flexibility of adding any station to any active session on an ad-hoc basis. 

 

 Stations will deliver tests for any testing purpose as described. 

o Intake/pretest sessions allow new student records to be added at time of testing and align 

with the recommended CASAS Intake Process for accurate test results and program 

placement. Refer to CASAS NRS Levels and Grade Levels for WIA Title I or CASAS and 

NRS Levels for WIA Title II for level placement. 

o Progress/Post-test session locks creation of new student records so that students must enter 

a pre-existing ID to ensure they are presented with the appropriate level post-test based on 

their most recent tests recorded in the online database. The recommendation is to post-test 

after 70-100 hours of instruction (40 hours minimum) to document learning gains. 

o Retest session gives you the opportunity to retest students on the same day if their pre-/post-

test score is below accurate range (*) – retesting required, or conservative estimate (s) – 

retesting recommended. The online system automatically adjusts to present the appropriate 

next-assigned test (NAT). 

o Returning session should be used when students return after being absent from instruction 

(NRS recommends 90+ days). This session re-administers the locator to determine the next 

appropriate-level test at time of return. 

o Registration* session affords the opportunity to separate the registration process from the 

testing process and gives you undivided time with students to assist them in applying their 

responses on data collection screens and addressing any questions. Refer to Data Collection 

Details. Students are also given the opportunity to practice taking a web-based test. 

*If you use the Registration session, data collection screens are skipped during an 

intake session and students can begin testing. 

*If you do not use the Registration session, students will complete the registration 

process during the intake session before they begin testing. 

o Practice session may be administered any time and multiple times. No results are recorded. 

The purpose of this session is to introduce students to CASAS web-based test delivery, not 

for determining basic skills. Lab assistants may allow students to practice any time, and 

instructors may incorporate practice in classroom lessons. 

 

 Test results are immediately accessible in both eTests and TOPSpro Enterprise Online. This 

includes generating reports in TE such as the Individual Skills Profile and Student Competency 

Performance report.  

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
https://www.casas.org/docs/default-source/pagecontents/casas-intake-process.pdf?sfvrsn=2?Status=Master
https://www.casas.org/docs/default-source/wiaandnrs/casasnrs-grade-wiaI.pdf?sfvrsn=13?Status=Master
https://www.casas.org/docs/default-source/wiaandnrs/casasnrs-wiaII.pdf?sfvrsn=17?Status=Master
https://www.casas.org/docs/default-source/wiaandnrs/casasnrs-wiaII.pdf?sfvrsn=17?Status=Master
https://www.casas.org/training-and-support/testing-guidelines/next-assigned-test-charts
https://www.casas.org/docs/te-help-documentation/data-collection-details.pdf?sfvrsn=10?Status=Master
https://www.casas.org/docs/te-help-documentation/data-collection-details.pdf?sfvrsn=10?Status=Master
https://www.casas.org/product-overviews/software/topspro-enterprise/sample-reports
https://www.casas.org/docs/topspro-enterprise-sample-reports/isp-john-morris.pdf?sfvrsn=4?Status=Master
https://www.casas.org/docs/topspro-enterprise-sample-reports/student-competency-performance.pdf?sfvrsn=4?Status=Master
https://www.casas.org/docs/topspro-enterprise-sample-reports/student-competency-performance.pdf?sfvrsn=4?Status=Master


Testing Sessions   
 

CASAS Online Implementation Basics                              © 2016 CASAS. All rights reserved. 7 

 

The following displays for each step to Create Testing Sessions were put together for hands-on lab 

training with multiple users at the 2016 CASAS National Summer Institute. To proceed, we ask that 

you substitute the following references when working through each step. A version with updated 

displays will be posted to our website soon! 

 

Template Name: 

 In place of the “unique” Template name of “Rabbit” 

o Use an Instructional Program name or acronym such as –  

 ABE for Adult Basic Education 

 ASE for Adult Secondary Education (includes HSD and HSE programs) 

 CIT for Citizenship 

 ESL for English as a Second Language 

 ELL for English Language Learners 

 ESOL for English for Speakers of Other Languages 

 HSD for High School Diploma 

 HSE for High School Equivalency 

Validity Period: 

 In place of 7/1/2015 – 7/1/2016 

o Use 7/1/2016 – 7/1/2017 

 

Step Display Description 

1.  

 
 

 From eTests Online Application Management, 

 

 Click Testing Sessions. 

2.  

 

 The Testing Sessions list opens to display –  

o Session Name 

o Site 

o Start/End Dates and Times 

o Proctor supervising the session 

o Status of the supervised session 

 

 By default, the list filters sessions in the 

Current Program Year, by 

o Site, and then by the 

o Session Full Name 

 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
https://www.casas.org/training-and-support/SI
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Step Display Description 

3.  

 

 The first session you will create is to establish 

an Instructional Program Template to ensure 

standardized test delivery. 

o From this Template, you will add 

customized sessions based on best 

practices. 

 

 You will spend the most time configuring the 

Template which also creates the first session in 

a set of customized sessions sharing the same 

Instructional Program Template name. 

o All other sessions that are added require 

only minor edits, or customization. 

 

 Now let’s get started. At bottom of the Testing 

Sessions list, 

o Click Create new Session. 

 

4.  

 

 A new session window opens in Edit mode. 

 

 With this first session, you are establishing the 

Instructional Program Template. 

 

 The Template ensures standardization among 

all sessions sharing the same Template. 

 

 The Template Name should not be changed 

when customizing Sessions sharing the same 

Template as doing so will result in non-

standardized testing for the Instructional Program. 

 

5.  

  
 

 Substitute “Rabbit” for  

o ABE, ASE (or HSD, HSE), CIT, ESL, 

etc. 

 

 

 To establish an Instructional Program Template 

Name, at left of the Edit Session Details 

screen, 

 

o Enter an Instructional Program name or 

acronym. 

 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
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Step Display Description 

6.  

 

 To continue, 

 

o Click the Site-field down-arrow. 

 

 From the drop-down menu, 

 

o Select your Site. 

 

7.  

 

 It is recommended that you not assign Stations 

to sessions to give Proctors maximum flexibility 

of adding any station to any “active” session on 

an ad-hoc basis. 

o Stations will deliver tests for any testing 

purpose described in the Session 

Description. 

8.  

 
 

 

*See Accommodations Guidelines on the 

CASAS website for more details. 

 The Students tab may be used to apply a specific 

configuration for a student or group of students 

such as –  

o overriding the next-assigned test (NAT), or 

o applying accommodations such as large 

screen display, or different test times.* 

 

 Student Configurations remain indefinitely so 

we would caution you on using this feature. 

o For example, you must remove a Student 

Configuration if overriding the NAT 

otherwise, the student will continually take 

the same test. 

9.  

 

 The first session in a set of sessions sharing the 

same Template establishes both the – 

o First Session, and 

o Template Configuration. 

 

 An Instructional Program Template controls 

standardization for – 

o What and how tests are delivered, and 

o What is collected and displayed during 

test delivery. 

 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
https://www.casas.org/training-and-support/testing-guidelines/accommodations-guidelines
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Step Display Description 

   After the session is saved, the Template and 

first Session is established. 

 

 From this point forward, any edit to the 

Template will simultaneously edit all Sessions 

sharing the same Template, but only within 

the same Site. 

 

10.  

 
 

 The first session is one of three Intake sessions 

which –  

o Allow new student records to be added 

at time of testing, and 

o Align with the recommended CASAS 

Intake Process for accurate test results 

and program placement. 

 

11.   At right of the Edit Session Details screen is the Session Description field to specify what 

makes this session unique among the set of sessions you will create. 

 

 If you have more than one Lab at each site, all Session Descriptions, not the Template, 

should include the Lab name. 

 

 To put this into practice, 

 

o First, enter the word LAB. 

 

o Followed by the name or abbreviation of the Lab at your Site, such as AC for 

Assessment Center. 

 

 Then, enter the Session Description. 

 

o Intake: Locator + Pretest. 

 

12.  

 
 

 The recommended Validity Period for all 

sessions is the Program Year (PY) date range of 

July 1 through June 30 of the following year. 

 

o Sessions may be used and reused 

whenever testing is needed throughout 

the program year. 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
https://www.casas.org/docs/default-source/pagecontents/casas-intake-process.pdf?sfvrsn=2?Status=Master
https://www.casas.org/docs/default-source/pagecontents/casas-intake-process.pdf?sfvrsn=2?Status=Master
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Step Display Description 

13.  

 
 

Note! By default, sessions expire at 

midnight. 

o This is why the To date is set for 

7/1/2017. 

 i.e., sessions expire 6/30 midnight. 

o Reusing sessions ensures standardized 

test delivery and testing practices. 

 

 To put this into practice, 

o Click the From field down-arrow. 

o From the drop-down Calendar, 

 Select 7/1/2016. 

14.  

 
 

 

 

*The Life and Work Reading series offers 

three options with different forms and 

focus at Level C. 

 

Life and Work emphasis at Level C 

81, 82, 83, 84, 85, 86, 185, 186, 187, 188 

 

Life emphasis at Level C 

81, 82, 83, 84, 185, 186, 187, 188 

 

Work emphasis at Level C 

81, 82, 83, 84, 85, 86, 187, 188 

 

 The first tab to configure is Modalities to specify 

what gets delivered. 

 The recommendation is to create separate 

Templates per instructional program such as 

ABE, HSD, or HSE that only delivers reading 

and math, and ESL that only delivers reading 

and listening. 

o For training purposes, these steps direct 

you to select NRS-approved 

assessments to serve multiple programs 

combined. 

 

 For Modalities, you will apply three settings. 

 

1. Check Reading. 

 

 Click the Reading field down-arrow. 

 

 From the drop-down menu, 

 

o Select a Life and Work option.* 

 

 By default, the Short Computer-Adaptive Test, 

or CAT, Form 102R known as the Reading 

Locator, is automatically set as a short appraisal 

to determine and present an appropriate-level 

reading pretest in the same sitting. 

 

o 7 - 9 test items will be drawn at random 

from the test delivery system. 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
https://www.casas.org/product-overviews/assessments/life-and-work-reading
https://www.casas.org/training-and-support/wia-and-nrs-compliance/nrs-approval-of-casas
https://www.casas.org/training-and-support/wia-and-nrs-compliance/nrs-approval-of-casas
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Step Display Description 

15.  

 

2. Check Math. 

 

 Click the Math field down-arrow. 

 

 From the drop-down menu, 

 

o Select Life Skills Math (LS Math 30 series) 

 

 By default, the Math Locator, Form 102M, is also 

set automatically followed by a pretest in the 

same sitting. 

16.  

 

Note! Typically, Templates are established for 

each Instructional Program. For example, 

o ABE to delivery reading and math, 

and 

o ESL to deliver reading and listening. 

3. Check Listening. 

 

 Click the Listening field down-arrow. 

 

 From the drop-down menu, 

 

o Select Life and Work Listening – 980 

series. 

 

 The Listening Locator, Form 89L, is also set 

automatically and will be followed by a pretest 

in the same sitting. 

 

o The Listening Locator is not adaptive 

and instead is a fixed-form with 9 items 

divided into 3 sets per item type. 

 

17.  

 

 The next tab to configure is to specify how 

tests are delivered. 

 

o Click the Options tab. 

 

 The online system uses a three-state model for 

all settings. 

 

 In user Edit mode, all boxes initially display 

with a dash. 

o A Dashed box indicates no specific 

setting. 

 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
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Step Display Description 

18.  

  

 Click Inherited. 

 

o This allows you to see default system 

settings that sessions will inherit unless 

enabled or disabled in user Edit mode. 

 

o A Checked box represents a setting that 

is enabled. 

 

o An Empty box is a disabled setting. 

 

 
Note! As you work through this tutorial, you will be directed to apply specific settings and 

leave other settings “as-is” for optimal system performance and for maximum benefit if/when 

an edit needs to be made to the Template. Any edit to an instructional-program template at each site 

will have a simultaneous effect in editing all sessions sharing the same template at that site. (i.e., inherit 

the edit). Therefore, many boxes will display a dash indicating an inherited state 

(recommended). 

19.  

 
 

 Because the online system tracks students 

and programs across multiple sites and 

classes through a unique ID, assigning a 

class to the test record is no longer 

necessary or required. 

 

o Without this restriction, test results 

may be used for multiple classes 

and programs to avoid over 

testing. 

 You will apply only two edits on the Options tab 

based on recommended best practices. 

 

 Click Edit, and in user edit mode, 

 

1. Check Allow ‘I don’t know’ on 

locator/appraisal. 

 

 Because the Locator is computer-adaptive, this 

will allow students to skip an item without 

responding. 

 

 This setting is recommended to help ensure 

accurate Locator results for determining an 

appropriate-level pretest. 

2. Click and clear box on Allow student to 

select class from other sites so that you 

have an empty box to disable the setting. 

 

 You are disabling this setting based on 

recommended best practices. 

 

 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
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Step Display Description 

20.  

 
 

 

 To verify all settings on the Options tab, 

 

o Click Effective. 

 

 This shows you a combination of 

user Edit and System-Inherited 

defaults combined. 

 

 Note that standard test administration times 

are inherited so specifying test times is not 

necessary. 

 

 Displayed are standardized times for which all 

CASAS tests are normed for accurate results. 

 

 These times should not be edited unless –  

 

o Configuring a session specifically for 

Accommodations requiring different 

timing for tests administered, or 

 

o To adjust the pre/post-test time for 

academic hours such as a college class 

scheduled for only 50 minutes. 

 

21.  

 
 

 Now let’s move on to specify what is collected 

when testing. 

 

o Click the Registration tab. 

 

 Click Inherited to see default system settings. 

 

 If your agency routinely imports student 

information from a 3rd Party System, then you 

would not be inclined to enable Registration 

settings. 

 

 However, for purposes of this tutorial you will 

proceed to enable Data Collection screens. 

 

 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
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Step Display Description 

22.  

 
 

Note! A Data Collection Details document 

is available on the CASAS website in eTests 

Online Help and TOPSpro Enterprise Help. 

 

o In the new version of eTests 

Online, data collection screens 

will include –  

 Address, 

 Phone, and 

 E-mail 

 

 For best practices, collecting and recording 

student information helps to –  

o Ensure data integrity, and 

o Provide details for program evaluation 

and analysis. 

 

 Collecting student information through eTests 

Online eliminates scanning Entry Records 

when students have a Class Enrollment in 

TOPSpro Enterprise Online. 

 

 Collect SSN was recently added and is not 

enabled by default. 

 

 Collect ward is for programs that identify 

students within specified regions and not 

within zip code boundaries. 

 

 For training, you will enable three data 

collection screens in addition to the Collect 

Program Information default already set. 

 

 Click Edit. 

1. Check Collect student demographics. 

2. Check Collect statuses and goals. 

3. Check Collect zip code. 

23.  

 
 

Note! Checked information displays on the 

test screen during and after taking a test. 

 Now the last tab you will configure is to specify 

what is displayed during and at the end of each 

test delivered. 

o Click the Layout tab. 

 

 Layout includes –  

o Toolbar display, and 

o End test display options. 

 

 Click Inherited to see default system settings. 

o As you will see, most settings are already 

enabled. 

 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
https://www.casas.org/docs/default-source/te-help-documentation/data-collection-details.pdf?sfvrsn=16?Status=Master
https://www.casas.org/training-and-support/etests-online-help
https://www.casas.org/training-and-support/etests-online-help
https://www.casas.org/training-and-support/topspro-enterprise-help
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Step Display Description 

24.  

 

 You will apply two recommended settings to the 

Toolbar based on best practices. 

 

 Click Edit. 

 

1. Check Show toolbar pinned, and 

 

2. Click and clear box on Show form 

number. 
 

25.  Toolbar Display 

 

 
 

 Students may unpin and re-pin the Toolbar at any time during testing by hovering with the 

mouse at top of the test screen. 

 

o Initially drawing the student’s attention to information displayed in the Toolbar may be 

helpful before they begin testing. 
 

o Not showing the form number during test delivery may help to eliminate memorizing 

and sharing answers. 

 

26.  
Personal Score Report (PSR) Display 

 

 The End-test report known as the Personal 

Score Report (PSR)automatically displays at the 

end of a test with recommended settings already 

enabled by default. 

 

 This report is a summary of the student’s 

performance on the test. 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
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Step Display Description 

27.  

 

 Click the Admin tab. 

 

 This tab specifies how sessions are managed. 

 

 You will not be making an edits on the last tab. 

 

 Click Effective. 

 

o These settings generally remain “as-is” 

unless there is a specific need to edit. 

 

28.  

 
 

 Before you save the Instructional Program 

Template and first Session, you will preview –  

 

o User Edits combined with 

o System-Inherited default settings. 

 

 While in Effective mode, 

 

o Click each Tab and preview combined 

settings. 

 

 If all looks good, at bottom of the Edit Session 

Details screen, 

 

o Click Save. 

 

29.   

TEMPLATE 

                                                                                                      Intake: Locator + Pretest Session 

 Now that the hard work is behind you and 

the Template and first Session is 

established, remaining sessions require only 

minor edits. 

 

 

 

 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
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Step Display Description 

  The Template established your standardized settings for –  

o What gets delivered – on the Modalities tab. 

o How tests are delivered – on the Options tab. 

o What is collected when testing – on the Registration tab. 

o What is displayed during and at the end of each test delivered – on the Layout tab. 

o How sessions are managed – on the Admin tab. 

 

 The Template also created your first Session in a set of recommended sessions based on 

best practices. 

 

 Any edit to the Template will have a simultaneous effect in editing all sessions sharing the 

same Template (per site). 

 

30.  

 
 

 Each session you add to your set of sessions will 

build on the last session. 

 

 To add the second Intake session, 

o At left of the Intake: Locator + Pretest 

session, 

 Click Copy. 

 

31.  

 

 Edit the Session Description to –  

 

o Intake: Level A. 

 

 Keep LAB and delete <copy>. 

 

32.  

 

 On the Modalities tab, you will make three 

edits. 

 

1. For Reading, 

 

 Click the Reading field down-arrow. 

 

 From the drop-down menu, 

 

o Click Select Form to Override with… 

 

 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
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33.  

 
 

 

 From the pop-up, 

 

o Click 081R (Life and Work Reading 

Level A, Fixed Form). 

 

 At bottom of the pop-up, 

 

o Click Select. 

 

 The Reading modality now displays –  

 

o Override with Single Form - 81R. 

 

34.  

 

2. For Math, 

 

 Click the Math field down-arrow. 

 

 From the drop-down menu, 

 

o Click Select Form to Override with… 

 

 

 

 

 

 

 

35.  

 
 

 

 

 From the pop-up, 

 

o Click 031M (Life Skills Math Level A, 

Fixed Form). 

 

o Click Select. 

 

 The Math modality now displays –  

 

o Override with Single Form – 31M. 
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36.  

 
 

3. For Listening, 

 

o Click the Listening field down-arrow. 

 

 From the drop-down menu, 

 

o Click Select Form to Override with… 

 

37.  

 
 

 From the pop-up, 

 

o Click 981L (Life and Work Listening 

Form 981, Fixed Form). 

 

o Click Select. 

 

 The Listening modality now displays –  

 

o Override with Single Form – 981L. 

 

38.  

 
 

 

 

 Click the Options tab. 

 

 Only two edits are needed on the Options tab. 

 

1. Uncheck and clear box on Allow ‘I don’t 

know’ on locator/appraisal. 

 

• This disables the ‘I don’t know’ button which 

does not apply to this session. 

 

2. Check Hide practice tests. 

 

 Hiding Practice Tests is recommended at this 

level to simplify the Test Menu and because 

students have already been introduced to the 

test screen when following the Intake Process 

outlined for ABE and ESL programs. 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
https://www.casas.org/docs/default-source/pagecontents/casas-intake-process.pdf?sfvrsn=2?Status=Master
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39.   

Intake: Level A Session 

 

 
 

 The Intake: Level A session will inherit all 

other Template settings so no other edits are 

needed. 

 

 Click Effective to see combined settings on all 

tabs. 
 

 At bottom of the Edit Session Details screen, 

 

o Click Save. 
 

40.  

 
 

 Now you will customize the third Intake 

session and continue building the set of 

sessions sharing the same Template settings to 

ensure standardization. 
 

 By copying, you benefit with combining 

settings applied to the previous session to 

continue adding sessions. 
 

 From the Intake: Level A session, 

 

o Click Copy. 

 

41.  

 
 

Beginning Literacy Reading 

 Assessing individuals whose literacy skills 

are at the lowest levels is simplified with 

the CASAS Beginning Literacy Reading 

Assessment. 

 Use these two progress tests (pre- and post) 

to comfortably ease the testing experience 

for non-readers and beginning readers.  

 Forms 27 and 28 are competency-based 

tests that focus on letter and word 

recognition and the concepts and 

conventions of print as they help 

instructors identify reading skill needs.  

 

 Rename the Session Description to read – 

 

o Intake: Beg. Lit. 

 

 Keep LAB and delete <copy>. 

 

 If you want to add Form 27R, or 28R to the 

Description to be specific, that’s fine since 

Beginning Literacy is only available for 

Reading. 

 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
https://www.casas.org/product-overviews/assessments/beginning-literacy-reading
https://www.casas.org/product-overviews/assessments/beginning-literacy-reading
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42.  

 
 

 

 On the Modalities tab, you will make three 

edits. 

 

1. For Reading, 

 

 Click the Reading field down-arrow. 

 

 From the drop-down menu, 

 

o Click Select Form to Override with… 

 

43.  

 

 From the pop-up, 

 

o Click 027R (Life Skills Reading 

Beginning Literacy, Fixed Form). 

 

o Click Select. 

 

 The Reading modality now displays –  

 

o Override with Single Form – 27R. 

 

 

 

44.  

 

2. For Math, Beginning Literacy forms are 

not available. 

 

 Click the Math field down-arrow. 

 

 From the drop-down menu, 

o Click Select Series (only Practice by 

Default). 

 

 Selecting Practice on the Modalities tab, 

combined with Hide Practice Tests on the 

Options tab, cancels each other so that no 

Math buttons display on the Test Menu. 

 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
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45.  

 
 

 

 

 

Intake: Beg. Lit. Session 

 

 

3. For Listening, Beginning Literacy forms 

are also not available so you will need to 

do the same setting as you did for Math. 

 

 Click the Listening field down-arrow. 

 

 From the drop-down menu, 

o Click Select Series (only Practice by 

Default). 

 

 Just like Math, no Listening buttons will display 

on the Test Menu. 

 

 All that will display on the menu is the Reading 

button for Form 27R or 28R, whichever you 

prefer to use. 

 

 No other edits are needed on other tabs because 

the Beg. Lit. session will inherit a combination of 

settings applied to customized sessions and 

inherit Template settings. 

 

 Click Effective to see combined settings on all 

tabs. 

 

 At bottom of the Edit Session Details screen, 

o Click Save. 

o  

46.  

 
 

 All three Intake sessions align with the 

recommended CASAS Intake Process for 

accurate test results and program placement. 

 

 The most-used sessions will be the Intake: 

Locator + Pretest session and the Post-test 

session which is the next session you will add. 

 

 From the Intake: Beg. Lit. session, 

o Click Copy. 

 

 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
https://www.casas.org/docs/default-source/pagecontents/casas-intake-process.pdf?sfvrsn=2?Status=Master
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47.  

 
 The recommendation for when to post-

test is after 70 - 100 hours of 

instruction to document learning gains. 

o The minimum allowed by NRS is 40 

hours between pre- and post-tests. 

 

 Rename the Session Description to read – 

o Progress: Post-test. 

 

 Keep LAB and delete <copy>. 

48.  
 

 
 

 

Note! Information is available on the 

CASAS website for Next Assigned Test 

charts. 

 

 You will apply three edits on the Modalities 

tab.  

 So that the session will inherit modality 

settings from the Template –  

1. Uncheck Reading. 

2. Uncheck Math. 

3. Uncheck Listening. 

 

 The online system automatically assigns the 

next test form. 

 

 Students will not take another Locator even 

though the Template setting includes it. 

 

 The test series + locator setting is what causes 

the alternating effect of always presenting the 

next-appropriate test form and level based on 

the most recent test results recorded online. 

 

49.  

 

 Click the Registration tab. 

 

 Only one edit is necessary on the Registration 

tab to avoid the risk of duplicated student 

records with mismatched test history. 

 

1. Check Lock creation of new students. 

 

 Students tested with this session are required to 

enter a unique ID that pre-exists in your online 

database. 

 

 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
https://www.casas.org/training-and-support/testing-guidelines/next-assigned-test-charts
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50.   

Post-Test Session 

 

 
 

 No other edits are needed for the Post-test 

session because it too will –  

 

o Inherit a combination of settings applied to 

customized sessions so far, plus 

 

o Inherit Template settings. 

 

 At bottom of the Edit Session Details screen, 

 

o Click Save. 

51.   

 The next session to add in the set allows retesting in the same day if needed and if time 

permits. 

 

 This session will give you the opportunity to retest a student on the same day if their pre- or 

post-test score is – 

 

 Below Accurate Range  Conservative Estimate  

 
These scores are displayed with an asterisk 

symbol (). 

o Scores are inaccurate / invalid. 

o Retesting is required. 

These scores are displayed with a diamond 

symbol (). 

o Scores are accurate / valid. 

o Retesting is recommended. 

Note! Test administrators are encouraged to administer 

the next more difficult test level to obtain a more 

accurate scale score estimate. This is automatically set 

by the online system. 

52.  

 
 

 From the Progress: Post-test session, 
 

o Click Copy. 

 

53.  

 
 

 

 Rename the Session Description to read – 

o Retest Same Day. 

 Keep LAB and delete <copy>. 
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54.  
 

 

 Again, you will make three edits on the 

Modalities tab to inherit Template settings. 

 

1. Uncheck Reading, 

 

2. Uncheck Math, and 

 

3. Uncheck Listening. 

 

55. 5

5

. 

 

 
 

 To allow retesting in the same day, 

o Click the Admin tab to apply one edit. 

 

 For Days between tests of the same modality, 

 

1. Enter ‘0’. 

 

 No other edits are needed for the Retest Same 

Day session because it too will inherit all other 

settings combined. 

 

 At bottom of the Edit Session Details screen, 

o Click Save. 

56.  

 
 

 Next, you will add a session to address 

students who return after being absent from 

instruction. 

 

 NRS recommends after 90 or more days to 

administer another appraisal to determine the 

appropriate-level test at time of return. 

 

 When the student returns, the locator is given 

again to determine the appropriate test. 

 

 From the Retest Same Day session, 

 

o Click Copy. 

 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
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57.  

 
 

 

 Rename the Session Description to read – 

o Returning after 90+ days absence. 

 

 Keep LAB and delete <copy>. 

 

 This description is to distinguish this session 

from the Post-Test session where students 

who are actively receiving instruction are 

tested to document learning gains. 

58.  

  

 

 For the session to inherit Modalities from the 

Template, you will make three edits. 

 

1. Uncheck Reading. 

 

2. Uncheck Math. 

 

3. Uncheck Listening. 

 

59.  
 

 
Note! The reason a locator or appraisal is 

administered again when a student returns 

after being absent from instruction for 90+ days 

is because the NAT (which is based on the last 

test a student took and would otherwise be 

presented to the student at time of return) is 

not necessarily appropriate given the elapsed 

period. 

 Click Options to apply three edits. 

1. Click and return dash on Allow ‘I don’t 

know’ on locator/appraisal setting to 

inherit the Template setting (i.e., re-

enable this option). 

2. Check Use locator/appraisal for next test 

to force the online system to administer 

the Locator again. 

 By design, the online system will not 

automatically administer the locator again. 

 Because of this design, you have to apply an 

override. 

3. Click and return dash on Hide practice 

tests to inherit the Template setting 

which allows students to practice before 

testing. 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
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60.  

  
 

 

 

 

 Now you need to remove the one edit on the 

Admin tab. 

 Click the Admin tab. 

1. Remove ‘0’ from Days between tests of 

the same modality so the box is empty 

and the session inherits Template 

settings. 

 No other edits are needed for the Returning 

students session because like the other 

sessions, it too will inherit all other settings 

combined. 

 The Test Menu will deliver and display the 

same as the Intake: Locator + Pretest session 

with the exception that –  

61.   

Returning after 90+ days absence Session 

 

 

o Lock creation of new students is enabled 

on the Registration tab from a previous 

session setting so that students must enter 

a pre-existing unique ID. 

 The purpose of requiring students to enter a pre-

existing ID is to avoid duplicate records of the 

same student and mismatched test history. 

 Click Effective to see combined settings on all 

tabs. 

 At bottom of the Edit Session Details screen, 

o Click Save. 

62.  
 The next session to add is for Registration. 

 This session gives you the opportunity to separate the registration process from the testing 

process to give you undivided time to assist students with applying responses and addressing 

their questions. 

 If you use the Registration session If you do not use the Registration session 

 
Data collection screens are skipped 

during an Intake session and 

students begin testing after entering 

an ID, first and last name, and 

saving their new student record. 

Students will complete the registration process 

during an Intake session before they begin 

testing. 
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63.  

 
 

 From the Returning students session, 

 

o Click Copy. 

 

64.  

 
 

 Rename the Session Description to read – 

o Registration. 

 Keep LAB and delete <copy>. 

65.  

 
 

 Three edits are needed on the Modalities tab. 

 

1. For Reading, 

 

 Click the Reading field down-arrow. 

 

 From the drop-down menu, 

 

o Click Select Series (only Practice by 

Default). 

 

 Because this is a testing application, all 

sessions must have Modalities enabled. 

o With Registration, students have the 

opportunity to practice before testing. 

 

66.  

 
 

2. For Math, 

 

 Click the Math field down-arrow. 

 

 From the drop-down menu, 

 

o Click Select Series (only Practice by 

Default). 
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67.  

 

3. For Listening, 

 

 Click the Listening field down-arrow. 

 

 From the drop-down menu, 

 

o Click Select Series (only Practice by 

Default). 

68.  
 

 
 

 Click the Options tab to apply three edits. 

 

1. Click and remove dash to clear box on 

Allow ‘I don’t know’ on 

locator/appraisal and disable the 

Template setting since this setting does 

not apply to Practice Tests. 

 

2. Check Allow ‘I don’t know’ on 

pre/post-test to mimic this choice on a 

Locator. 

 

3. Click and return dash on Use 

locator/appraisal for next test to inherit 

the Template setting. 

 

69.  

 

 Click Registration to apply two edits. 

 

1. Click and return dash on Lock creation 

of new students to inherit the Template 

setting so that new student records may 

be added to your online database during 

Registration. 

 

2. Click and remove dash to clear box on 

Collect program information to disable 

the Template setting since program 

placement is yet to be determined. 
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70.  

  

 Click the Layout tab to apply one edit. 

 

1. Click and remove dash to clear box on 

Show remaining time to disable the 

Template setting. 

 

 Because Practice mimics pre/post-testing with 

standard 60-minute test time, 

o Showing time remaining for a 6 or 9 item 

Practice may alarm students if they saw 

this amount of time in the retractable 

Toolbar. 

 

71.  Registration Session 

 

 
 

 After students complete Registration 

information, they have the opportunity to 

practice taking a test. 

 

 This session could also be used in a school 

lobby for students to enter information 

after registering for an ID with the school. 

 

 No other edits are needed for the Registration 

session. 

 

 Data Collection screens will be presented to 

students followed by a Test Menu that only 

offers Practice Items. 

 

 Click Effective to see combined settings on all 

tabs. 

 

 At bottom of the Edit Session Details screen, 

 

o Click Save. 

 

72.  

 

 The last session in this set is for Practice. 

 

 This session will give students the opportunity to 

practice without risk of launching into a test. 

 

 From the Registration session, 

 

o Click Copy. 

 

73.  

 
 

 Rename the Session Description to read – 

 

o Practice. 

 

 Keep LAB and delete <copy>. 

 

https://www.youtube.com/playlist?list=PLKYsn7abfofFIsGatgY-SbZR_4tNLH9R0
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74.  

 

 Only four edits are needed for the Practice 

session. 

 Click the Registration tab. 

 Click to remove checks and dashes to clear boxes 

and disable Template settings for –  

1. Collect student demographics. 

2. Allow update on student information. 

3. Collect statuses and goals. 

4. Collect zip code. 

75.  
Practice Session 

 

 

 As with all other sessions in the set, the Practice 

session will inherit combined settings. 

 Click Effective to see combined settings on all 

tabs. 

 At bottom of the Edit Session Details screen, 

o Click Save. 

76.  

 

 You now have a set of 8 customized Testing 

Session records sharing the same Template. 

o At one Site. 

o In one Lab. 

o For one Instructional Program. 

 

 
CONGRATULATIONS! 

Your work on establishing a standard set of sessions is done for the entire program year. Now all that 

remains is to –  

 COPY sessions in the same order as created to retain combined settings and –  

o Add sets for other Labs within the same Site. 

 Copy and only edit Session Description to include Lab name, remove “<copy>” from 

Session Description, and then Save. 

o Add sets for other Sites. 

 Copy and select new Site, remove “<copy>” from Session Description, and then Save. 

Prepare for the new Program Year (PY)! 

o Use the new Batch Replicate feature in TE to copy a group of sessions into the new program 

year with the Click of a button! 
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